
|  

sarah
Typewritten Text
SAMRC Burden of Disease Research Unit | July 2020



  

  

  

  

2  

  

 

1. Introduction to Microsoft teams…………………………………………………………………………………..……2  

2. Introduction to Kobotoolbox………………………………………………………………………………………..……6  

3. Basic Excel tips…………………………………………..……………………………………………………………..……..17  

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
 

 

 

 

 

 

  



3  

  

Microsoft teams – Accessing patient records  
  

1.1 What is Microsoft teams  
  
It is an online platform to share documents and have conversations with fellow team members. It is 
secure, exclusive to invited participants and best of all, it is free and easy to install.   

  

For the purpose of this study, you will be two reviewers per team. The cases (patient records) will be 

distributed to you as “Batches”, in Microsoft teams, for you to review and certify. You will review 

and certify cases independently, but if there are discrepancies between reviewers for a particular 
case, the SAMRC reviewers will notify you and you can use Microsoft teams to discuss the case with 

your team to reach consensus. Where you do reach consensus, one member of the team should 
submit a new (third) record for the case. In consensus cases you will need to use a Reviewer ID made 

up of the letter C followed by both reviewers 2 digit IDs (insert 0 in front of single digit IDs) from 

smallest to largest e.g. Reviewer 01 and Reviewer 08 would be C0108. There will be appropriate 

places for this on the Kobo VA review form.  

  

You will also be invited to a general team on Microsoft teams for group discussion when needed.   

  

There will also be a Whatsapp group with all the doctors who are certifying. The purpose of the 

group is to give notifications if there are anything important to take not of e.g. if a questionnaire has 
been updated.    

    
1.2 How to access Microsoft Teams  
  
A link will be emailed to you by Pam Groenewald (Teams NCODV VA reviews team). Once you have 
joined the Team through the email link, you will be able to access it by simply opening Microsoft 

Teams and following the prompts for installation.   

 
  

  

  

Download the desktop app for full functionality of Microsoft Teams.  
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Once you have downloaded the app onto your computer, it is easily accessible by clinking on the  

Microsoft Teams icon. The documents (batches) in Microsoft teams will be updated centrally by Dr 
Groenewald.  The two reviewers paired together will be able to access the information uploaded 

onto their team. All interfaces will however look identical.  

  

  

13. How to access patient records (Verbal autopsies, Medical and forensic records)  

   

For the first phase of data capturing, we will be certifying UCOD using the VA records.   

  

Open Microsoft teams  

  

Click on the Teams button on the blue, left sided column  

  

Click on the VA records tab under TEAMS-NCODV-VA   

  

Click on files, you will see it in the top horizontal tabs (not file in the blue, left sided column)  

  

Click on a folder to open it (e.g. Batch 1): New Batch folders will continuously be uploaded onto 

Teams. Each Batch folder contains 40 folders, each of which is a different VA case, identified by the 

case’s unique study identity number.  
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At the bottom of the Batch folder, there is an Excel document. This is the Excel spreadsheet that 

contains all the VA questions and answers for the 40 cases in the batch. You have the option of using 

either the excel format or the original VA questionnaire with answers (you will need to request the 
original VA pdf from Pam as the file will first need to be anonymised). But we recommend using 

Excel for ease of reviewing.   
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After you opened a batch, you will see the list of cases labeled according to their unique study 

identifier.   

  

 
  

Open one of the case folders (eg. 101013). Inside each case folder, you will find a photograph/s of 
the narrative and for children, if available, Road to Health Book.  

  

 
  

  

Once you have opened a file, you can go back to the case folder by clicking close in top right corner. 

Be sure to confirm the study ID on the document matches that of the case you are working on. If you 
find a document that has been placed in the wrong folder, please alert Pam ASAP. 

(Pamela.groenewald@mrc.ac.za)   
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Reminder: Please keep in mind that the information within these documents is sensitive and 

confidentiality etiquette applies.   

  

If you notice anything of concern within these records that pertain to misconduct in the clinical 

setting, please contact Pam in order for the matter to be addressed appropriately. Please do not 

contact the hospital concerned or discuss with anyone else.  

Kobotoolbox  
To be used with Microsoft teams. You will receive all the case information on Microsoft teams and 

then you use Kobotoolbox (either on tablet or computer) to capture the case information and certify 
underlying cause of death.   

  

1.1 Lenovo Tablet  
  

Switch on Lenovo Tablet – power button is lower button on right hand side. To 
unlock the tablet, slide upward on the screen.  

  

At the bottom of the screen, there is a triangle, a circle and a square. The triangle is the back button.  

  

Click on the white circle with 6 dots in the bottom centre of the screen to open the application 

menu.  
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You can get to the KoBocollect icon either by tapping the white circle and go to app via the 

applications menu. Or you can swipe right and see the KoBocollect short cut icon at the top the 
screen.   

  

Click on KoBoCollect.                                                     

  

If it prompts you for a 4 digit 

password.  

The KoBoCollect app will open. To 

download the correct questionnaire, 

click Get Blank Form and wait for it to 
connect to server.   
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Select Verbal Autopsy Review NCODV Main study (blue tick). And click Get selected at the bottom 

right hand corner.   

likely that there will be adjustments to the form. You will be informed 
if there is an updated questionnaire available. In that case, you also 

go to get blank form and select the document with the green text 

underneath the title: This is an upadated version of a form you 
already have.  

As the project continues, it is  

1835   
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To complete a questionnaire:   

  

Practical thing to consider when filling in the questionnaire: To move to next page of questionnaire, 

slide finger from right to left across screen. To go back, similarly slide finger from left to right.  

  

Click on Fill Blank Form and select Verbal Autopsy Review NCODV Main study form  
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Be sure to enter your Certifier ID, Unique Study ID and batch number for every case correctly. There 
will be a question later in the questionnaire that will ask you to confirm the unique study identifier.   

  

 
  

To enter the date manually, press on and hold down on the year or day to bring up the keyboard. 
You can also scroll to the correct date.   
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At the top right corner, there is an icon of an arrow pointing to a dot (see image below). This takes 

one to all the questions in the questionnaire in a list format.  At the bottom of the list of questions, 

one can go to start or go to end of the questionnaire, or click on the question you want to go to.                                       
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At the end of the questionnaire; Name this form as the Verbal Autopsy Unique Study ID. (E.g. 

201108)   

  

To save a draft, untick Mark form as finalized. (This box will be ticked automatically, so be sure to 
untick it.) Click Save Form and Exit.   

  

To open a saved draft, press Edit Saved Form. The number next in brackets shows the number of 

saved forms. Then select the form you wish to edit.                        

  

 
  

  

  

  

  

  

  

  

  

  

  

Submit finished case:  

  

When you are satisfied with the certification and finished all editing, go to end of questionnaire, tick 

Mark form as finalized.  
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Click Save Form and Exit    

   

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

To submit a finalized questionnaire, press Send Finalized Form on the Kobocollect main menu.  

  

Select the form (questionnaire case number) you would like to submit, and press Send Selected at 

the bottom right. (You can submit multiple forms at a time. Be sure to only submit forms that are 
complete)  
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To delete a file:  

  

Select Delete Saved Form  

  

You can delete saved forms (completed forms that have been saved) on the top left or blank 

forms (questionnaire forms) on the top right. Select the forms you want to delete (blue tick).  

  

Click on Delete Selected at the bottom of the screen.  

  

After downloading an updated version of the verbal autopsy review form, it is advisable to delete 
the old form to prevent confusion. Be sure to select and delete the older form, added on the earlier 
date.  
  

Once finalised forms have been submitted, these too can be deleted. Make sure you have submitted 

the forms before deleting.     
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1.2 How to access KoBoToolbox on a computer or laptop  

Go to https://www.kobotoolbox.org/  

Please use Google Chrome to access KoBoToolbox. It is only compatible with Google Chrome and 

NOT with other internet browsers (e.g. Internet Explorer, Microsoft Edge, Safari, etc).  

 
Scroll down to the login tab. Click on login on the righthand side. 

 
Login using username:   password:   

 
Select questionnaire named Verbal Autopsy Review NCODV Main study 

https://www.kobotoolbox.org/
https://www.kobotoolbox.org/


  

  

  

  

18  

  

  
Scroll down to collect data and select open. 

  
Complete the questionnaire.   

Insert your certifier ID and the Verbal Autopsy Unique Study ID. This is very important. When 

entering dates (e.g. for date of birth) the correct format is YYYY-MM-DD. Do not omit any digits. 

For example, DOB 5 July 2001 must be entered 2001-07-05. 

  
At the end select Save Draft. One can save draft even if the questionnaire is incomplete, but be sure 

to complete the questionnaire at a later stage. 
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Insert the record name using the Verbal Autopsy Unique Study ID.  

  
Click on the number in top left hand corner (Records queued) to open the record saved as draft. 

  
Click on the record displayed in the Queue to open it. 
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When you are ready to submit the document, go to the end of the record, untick Save as draft and 

select Submit.                      
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Basic tips in Excel  
  

Excel has some useful functions for making it easier to make sense of a spreadsheet with a lot of rows 

and columns.  

Freezing panes  
This enables you to keep an area on the spreadsheet you’re viewing visible while scrolling to another 

area on the same spreadsheet  

To freeze rows  

1. Select the row below the row(s) you want to freeze. For example, using the final VA data home 
assignment spreadsheet, select row 3 to freeze rows 1 and 2  

 

2. Click the View tab on the ribbon, then select Freeze Panes. You will get a drop-down menu.  
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3. Select Freeze Panes from the drop-down menu.  

 

4. This will freeze rows 1 and 2 in place (you will see a dark gray line) and allow you to view the VA 
case number and VA Unique study ID as you scroll down the spreadsheet.  

 

To freeze both rows and columns:  

  

1. Select the row below the row(s) you want to freeze (as shown in section x above)  

  

2. Then select the first cell to the right of the column(s) you want to freeze  

 

3. Click the View tab on the Ribbon, then select the Freeze Panes command and Freeze Panes from 
the drop-down menu  

4. This will freeze rows 1 and 2, and Column A in place (you will see a dark gray line) and allow you to 

view the VA case number and VA Unique study ID, as you scroll down the spreadsheet.  
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Furthermore, you will also be able to view the VA responses for the specific study ID you want 

across the spreadsheet with the question in Column A.  

 

You can use the highlighted tab to scroll across the spreadsheet.  

  

5. To unfreeze panes, click the View tab on the Ribbon, then select the Freeze Panes command and 

Unfreeze Panes from the drop-down menu  

 

  

Filter  
The Filter command in Excel allows you to view only the data you are interested in on your spreadsheet. 

For example, when you get feedback on certification for VAs, you can filter the list to limit the data you 
see to only those specific to your Reviewer ID.  

1. Select the Data tab and locate the Sort and Filter group.  
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2. Click the Filter command.  

  

  

3. Drop-down arrows will appear in the header of each column. Click the drop-down arrow for 

the column you want to filter. For example, Reviewer ID. This displays the Filter menu.  
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4. Uncheck the boxes next to the data you don't want to view or uncheck the box next to Select 
All to quickly uncheck all, and then check your preferred box.  

  

  

5. Click OK. All other data will be filtered, or temporarily hidden. Only Reviewer 5’s responses will 

be visible.  

  
  

Useful links  

https://edu.gcfglobal.org/en/excel2013/freezing-panes-and-view-options/1/  

  

https://edu.gcfglobal.org/en/excel2013/freezing-panes-and-view-options/1/
https://edu.gcfglobal.org/en/excel2013/freezing-panes-and-view-options/1/
https://edu.gcfglobal.org/en/excel2013/freezing-panes-and-view-options/1/
https://edu.gcfglobal.org/en/excel2013/freezing-panes-and-view-options/1/
https://edu.gcfglobal.org/en/excel2013/freezing-panes-and-view-options/1/
https://edu.gcfglobal.org/en/excel2013/freezing-panes-and-view-options/1/
https://edu.gcfglobal.org/en/excel2013/freezing-panes-and-view-options/1/
https://edu.gcfglobal.org/en/excel2013/freezing-panes-and-view-options/1/
https://edu.gcfglobal.org/en/excel2013/freezing-panes-and-view-options/1/
https://edu.gcfglobal.org/en/excel2013/freezing-panes-and-view-options/1/
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https://edu.gcfglobal.org/en/excel2010/filtering-data/1/  

  

https://edu.gcfglobal.org/en/excel2010/filtering-data/1/
https://edu.gcfglobal.org/en/excel2010/filtering-data/1/
https://edu.gcfglobal.org/en/excel2010/filtering-data/1/
https://edu.gcfglobal.org/en/excel2010/filtering-data/1/
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Consensus case on Kobotoolbox 

 
 

1. After both certifiers have completed a batch (VA records) and submitted their (+- 40) 
cases on Kobotoolbox either on laptop or the provided tablet. Then a quality assessor 
(QA) will go over the cases to see if both underlying cause of death (UCOD) for each case 
correlates with each other. The QA will also make sure that the causal sequence makes 
sense. 
 

2. The QA will post an Excel spreadsheet within your Microsoft Teams channel and 
communicate general comments or certain instructions.  

 
3. Once you have looked at the Excel sheet, you can start discussing the conflicting cases 

with your certifying partner and reach a consensus on the UCOD for that case. You can 
have the discussion on Microsoft teams. (Picture instructions to follow in this 
document) 

 
4. Now you are ready to submit a consensus:  

a. Divide the cases up evenly. Each person to submit the same amount of consensus 
cases so that HR can calculate how much you need to get paid. (If you have an 
uneven number, you can alternate who submits the higher number in the next 
batch)  

b. You use the same form you used for submitting your initial cases on Kobotoolbox.  
c. When submitting a consensus case you will answer a few things differently: 

i.  You will indicate that this is a consensus case (not an independent 
review). 

ii. There will be an option to give consensus reviewer ID. The number will be 
capital C (for consensus) followed by your certifier ID number and then 
your partner’s certifier ID. For single values you need to put a 0 (zero) in 
front of it. E.g. for certifier 4 and certifier 36, certifier 4 will submit C0436 
and certifier 36 will submit C3604. 

d. When submitting/saving your consensus case at the end of the form you also 
need to state the consensus reviewer ID. E.g. C0436 

e. Some of these Verbal autopsy cases are tricky, so if you cannot come to a 
consensus or are unsure about certifying rules. Please inform the QA and then 
the cases will be reviewed by a third doctor. If the third doctor cannot conclude 
the case, the case will be reviewed at a panel discussion.  
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Communicating on Microsoft Teams  

 
1. You will be notified via Microsoft teams when you need to submit a consensus case. A 

quality assessor will review your submitted cases. They will attach an excel spreadsheet 
with the cases for review and a few comments within your specific team e.g. 
TEAMS_NCODV_RecRev04.  

 
2. To go to your team: On the left-hand column (Navy blue) you will see tabs (picture icons) 

listed; activity, chat, teams etc. Click on Teams icon. 
 

3. In the white column next to the picture icons you will see your team. Click on your team 
e.g. TEAMS_NCODV_RecRev04 and it will give you drop down options saying General or 
VA records04 
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4. Let’s get the conversation started - Multiple ways to do this: 

 
- Within your specific team under VA records you can discuss the cases with each other to 

get to a consensus on the particular cases. Go to the conversations tab on the top 
horizontal bar. Start a new conversation in the white bar at the bottom of the screen. 
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- Alternatively, you can also have private conversations. Go to the Chat icon in the left-
hand column. You can send messages to either the person facilitating your team or with 
the other certifier when you need to reach consensus on a case or you just discuss your 

lovely weekend plans 😉  

 
- Go to the contacts tab on the left-hand white column. There you can add a contact. 

Select the contact you want to chat to. Start typing your message in the white bar at the 
bottom of the screen. In the top right-hand corner, there are blue picture icons with 
options to phone or video call the contact. 
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- There is also a Call icon (Left-hand column) that you can use.  
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Document content 

- Opening Kobotoolbox step by step guide 
- Opening Kobotoolbox explained with screen shots 
- The 15 cases for the home assignment  

 
Step by step guide: How to open Kobotoolbox and to submit assignments on computer 

1. Go to https://www.kobotoolbox.org 

2. Scroll down to the login tab: Researchers, aid workers and everyone else 

3. Login using Username: XXXXX   Password: XXXXX 

4. Select questionnaire named Verbal autopsy review questionnaire 

5. Right side of the screen under quick links select the tab: Collect data 

6. Scroll down, in the bottom right hand corner click: open 

7. Insert your Certifier ID and select Relevant Verbal autopsy case number 

8. Complete the form 

9. Duration between onset of conditions and death 

-  If immediate select: 0 and minutes as unit. 

-  Unknown duration select: 9999 for the duration and select the appropriate unit eg. If you 

know that it was a number of years, select 9999 for duration and select years for the unit. 

10. Once you have completed the form tick: Save as Draft  

11. Insert the Record name using the verbal autopsy case number of the Case Scenario ex. VA Case 1 

12. If you are happy with your answers and want to submit: Click on the number in top left hand 

corner (Records queued) to open the record saved as draft. 

13. Click on the record displayed in the Queue to open it 

14. Go to the end of the record, untick the Save as draft and then click Submit 

15. Continue until all 13 case scenarios have been completed and submitted. 

16. The total number case scenarios will still be queued in the top right hand corner, click on the 

number. A drop down column will appear listing all the cases. Click on the upload button at the 

bottom of the column.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.kobotoolbox.org/
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Screen shot guide (same as above) 

1. Go to https://www.kobotoolbox.org 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Scroll down to the login tab: Researchers, aid workers and everyone else 

 

 

 

 

 

 

 

 

 

3. Login 

using 

Username: 

pgroene21   

Password: 

NCODV 

 

 

 

 

 

 

4. Select 

questionnaire 

named Verbal 

autopsy review questionnaire 

https://www.kobotoolbox.org/
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5. Right side of the screen under quick links select the tab: Collect data 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. Scroll down, in the bottom right hand corner click: open 
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7. Insert your Certifier ID and select Verbal autopsy Case number 1 
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8. Duration between onset of conditions and death 

-  If immediate select: 0 and minutes as unit. 

-  Unknown duration select: 9999 for the duration and select the appropriate unit eg. If you 

know that it was a number of years, select 9999 for duration and select years for the unit. 

-  

9. Once you have completed the form tick: Save as Draft  
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10. Insert the Record name using the Verbal autopsy case number ex. VA Case 1 

 

 

 

 

11. If you are happy with your answers and want to submit: Click on the number in top left hand 

corner (Records queued) to open the record saved as draft. 

 

 

 

 

 

 

 

 

 

 

12. Click on the 

record displayed in 

the Queue to open it 
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13. Go to the end of the record, untick the Save as draft and then click Submit 

 

 

 

 

 

 

 

 

 

 

14. Continue until 

all 13 case scenarios 

have been 

completed and 

submitted. 

 

15. The total number case scenarios will still be queued in the top right-hand corner, click on the 

number. A drop down column will appear listing all the cases. Click on the upload button at the 

bottom of the column.  
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Accessing the VA review form on tablet  

For the reviewers having trouble getting the VA review form on Kobocollect 

using the tablet. It is the tablet server setting.   

  

4 April 2019  

    

Step by Step instructions to access VA review form  
Only for those who are having trouble accessing the VA review form on the tablet (Kobocollect)  
  

1. Go to General Settings – click on the three vertical little dots top right hand –   

 

2. Click on General Settings  
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3. Click on Server  

 

  

4. If you see the following, it is incorrect:  
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5. Under URL link should not contain /kobodemouser. This points to the wrong server and 

should be removed. Click on the server name to change. Simply backspace to remove 

/kobodemouser. Server name should look like this 

 

 

Backspace /kobodemouser  
 

6. Type in Username and password:   
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7. return to main screen and refresh and download form (Get Blank Form/Tick form you 

need/Refresh 
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